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Introduction
Welcome to GlobalCAD Landscape 2016, the integrated AutoCAD/BricsCAD add-on solution for landscape design, land
planning and irrigation.
GlobalCAD Landscape helps realize your ideas and deliver winning designs ahead of time.

This user guide provides step-by-step instructions on getting started with the interactive plant database reference guide,
entitled Plantasia Professional, which comes pre-installed with GlobalCAD Landscape.
Plantasia Professional is the unrivalled, interactive encyclopedia of plants and flowers. Plantasia provides instant access
to plant data including growth and cultivation tips, plant photographs, illustrations and much more.
This software is furnished under a license agreement and may be used only in accordance with the terms of the
agreement. GlobalCAD, GlobalCAD (logo), Plantasia and Plantasia (logo) are trademarks of GlobalCAD Consultants Ltd.
Copyright (c) 2000-2015 GlobalCAD Consultants Limited. All rights reserved.
Microsoft, MS, Windows, Windows NT, Word, Excel, Outlook, Outlook Express and Windows Address Book are either
registered trademarks or trademarks of Microsoft Corporation in the USA and/or other countries.
Plantasia 2016 Professional (version 1.2) is compatible with Windows XP, Windows Vista, Windows 7 and Windows 8.
Multi-user licensing options are available and provide support for all major network platforms including Windows Server.
Email Pre-Sales: info@globalcad.com
Tel:
Fax:

+44 (0) 1252 703939
+44 (0) 1252 703910

Web Site: www.globalcad.com
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Ordering Information
GlobalCAD Landscape 2016 is compatible with BricsCAD Pro/Platinum V11-V16 and the entire family of AutoCAD
products including AutoCAD 2007-2016, AutoCAD Architecture, AutoCAD Civil 3D, AutoCAD Land Desktop and
AutoCAD Map 3D.
The software can also be used in conjunction with other AutoCAD third-party applications. Multi-user licensing options
are available and provide support for all major network platforms including Windows Server.
Free unlimited screen-based technical support is provided, with telephone options also available to registered customers.
In addition, all GlobalCAD products carry a 30-day guarantee against defects in material and workmanship.
Purchase orders are accepted only from government and accredited educational institutions and major corporations,
provided that they are submitted on purchase order forms with a purchase order number (net 30 days). Please be sure to
include the standard order form with your order.
All product orders are dispatched with a printed invoice. For further details, please view the GlobalCAD Landscape 2016
order form.
Email Pre-Sales: info@globalcad.com
Tel:
Fax:

+44 (0) 1252 703939
+44 (0) 1252 703910

Web Site: www.globalcad.com
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Start to Use Plantasia
The interactive plant database reference guide, entitled Plantasia Professional, comes pre-installed with GlobalCAD
Landscape. This standalone software application is accessible via the Plant Database link, located under the
GlobalCAD Landscape group on the Windows program bar.

Starting Plantasia for the First Time
Start Plantasia by doing one of the following:

• Double-click the Plant Database icon on the Windows desktop.
• From the Windows Start menu, choose Programs > GlobalCAD Landscape 2016 > Plant Database.
The Plantasia main display appears, ready for use.

• Click a folder in the left navigation pane of the window (‘Navigation View’) to display its contents in the right two
panes. You can display folders within a folder by clicking the plus signs.

Notes

• To change the size of any pane within the Plantasia window, drag the bar that separates the two panes.
• Plantasia Today displays a list of all available Plantasia applications – known as Plug-Ins – in the right pane of the
window.

To Move/Copy Items using Drag and Drop
• Using the Navigation View, find the item you want to move/copy.
• Make sure the place you want to drag the item to is visible.
• Drag the item to the destination.
Notes

•
•
•
•

You can also drag items from the top-right Table View and drop them into folders in the Navigation View.
If you right-click to drag, a menu appears with the available options.
You can select multiple items to move/copy by pressing Ctrl while you select each item in turn.
A ‘No Entry’ icon will appear if you try to drag items to a location that does not support them.
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Working with Projects
With its project-based technology, Plantasia provides a powerful and flexible way for you to organize your project data.
Before you can begin to link plants, your cost data and notes together you need to create one or more projects. You
create a new project in the Navigation View. You can give the project any name you want, and you can add as many
plants as you want to the project. Keep in mind that a single plant can belong to several projects.
When you add a new project, you can provide summary information on the client and project location. This information is
displayed in the summary view for that project.

Creating a New Project
You create a new project in the Navigation View. You can give the project any name you want, and you can add as many
plants as you want to the project.
Create a new group by doing either of the following:

• From the File menu, choose New > Project
• Click the New Project tool in the toolbar.
The Create New Project dialog box appears.
Entering the project name and summary information:

• In the Name field, enter the name for this project. This will be used as the folder name in the Navigation View.
• Enter the project author, client name and project location in the remaining fields.
• Click OK to create the new project.
The new project becomes the Current Project in the Navigation View.

Page 7 of 16
Copyright © GlobalCAD. All rights reserved.

Plantasia Encyclopedia
The interactive Plantasia encyclopedia is the unrivalled reference work for gardening enthusiasts, landscaping and
horticultural professionals. You’ll find extensive data on over 10,000 wild and cultivated plants all fully indexed for instant
access. Advanced search tools provide invaluable help in choosing the right plants for the right location. You can modify
existing plant details; add notes, supplier and cost information.
Key features include:

• A vital resource, the interactive encyclopedia references precise details on thousands of plants worldwide with the
latest digital pictures, illustrations and essential cultivation data.

• Create your own personalized plant lists quickly and easily using drag and drop. Copy plants and related cost data
directly from the encyclopedia into personal project folders.

• Direct schedule links to popular packages including Microsoft Word. Professional templates are available and include
designs for informative plant fact-sheets.

• With its advanced search tools you can find and view details on selected plants that are right for your project.

Setting Options
Working with the Plantasia encyclopedia can be more efficient if you specify the Units of Measurement and other settings
to apply at start-up.
To specify the Units of Measurement:

• From the Tools menu, choose Options.
• On the Options dialog box click the Plantasia tab.
• Select the unit of measure and temperature settings.
To specify the plant export template settings:

• In the Export Options group box, select the document format. Options are MS Word, Excel or RTF Editor.
Choosing the RTF Editor option will open documents using your system’s default text editor software.

• From the Paper Size drop-down list, choose one of the paper sizes supported by your printer.
• Click Edit Temple to customize the master Plant Export template (optional).
Warning! Saving master template changes affects the appearance of the template in all new projects.

Using Plantasia Encyclopedia
The Plantasia encyclopedia is the ideal reference when planning a garden or landscape scheme, selecting plants or
identifying specimens; it provides a wealth of information on the appearance and cultivation of thousands of individual
plants. The encyclopedia brings together plant portraits and descriptions in a colorful catalog that is divided into groups:
Alpine
Aquatic
Bamboo
Cacti
Climbing
Conifer
Fern
Grass

Herb
Ornamental
Palm
Shrub
Succulent
Tree
Vine
Wildflower

To open the Plantasia encyclopedia:

• In the Navigation View, double-click the Plantasia folder.
The various plant groups are now displayed as sub-folders.

• Click the plant group of interest.
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The top right Plant List now displays the contents of the plant group. Individual details on each plant are displayed in
the form of tabs in the Plant View below. Select a plant in the Plant List then click on the tabs to view more details.
Creating a plant cost profile:

• Select the relevant plant so its details are displayed in the Plant View.
• From the Cost Profile tab, enter the cost information.
You can enter a reference, supplier code, unit cost and notes for the plant.
Notes

• From the Plant List view, you can quickly sort plants into ascending or descending order by clicking on the relevant
column heading.

• For further details on plant costs and how to calculate quantities, refer to the help topic Project Costing.

Searching for Plants
You can sort plants within a group in the Plant List or search for plants matching a certain criteria using powerful search
tools. If you know a plant but cannot recall its name, have a specimen that you want to identify, or simply wish to choose
plants for your scheme based on their size or coloring, the Search tab will provide the answer.
To sort plants using the Plant List:

• Select the plant group of interest.
• In the Plant List view, click on the relevant column heading to change the sort order.
Column headings include Genus, Species, Variety, Plant Type and Climate Zone. By default, the Plantasia
encyclopedia sorts plants by genus, species and variety in ascending (A to Z) alphabetical order.

• If you sort by multiple columns, you can hold down Shift and click the column heading to change the direction of the
sort.
To perform an advanced search:

•
•
•
•

Select the plant group of interest.
From the Search tab, decide on your preferred search criteria combination.
Type your search words in the relevant text boxes or choose from the pre-defined drop-down lists.
Click the Search button when you are done.

Notes

• Results of the search are displayed in the Plant List, with the plant count shown on the status bar.
• In order to maximize the number of plants found during a search, limit the number of search combinations used.
• Clicking on the Search tab Clear button resets the current plant group.

Adding Plants to Projects
Each project contains a Plants folder, which provides a convenient place to store plant information relating to the current
project. Organizing plants within projects provides you with many benefits:

•
•
•
•

Create plant lists for a particular site, soil or purpose.
Assign project specific cost profiles to plants.
Quickly generate cost analysis for an entire project.
Add cultivation notes unique to a project.

Plants grouped under projects can also serve as a saved lookup of plant records that you often need to access. For
example, you may want to group all the perennial shrubs, frost tender ornamentals or trees for exposed sites.
To add plants from the Plantasia encyclopedia:

• In the Navigation View, double-click the Plantasia folder. The various plant groups are now displayed as sub-folders.
• Click the plant group of interest.
The top right Plant List now displays the contents of the plant group.
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• Find the plant(s) you want to copy and drag and drop them into the relevant project.
To add plants from another project:

• In the Navigation View, double-click the source project folder.
• Click on the Plants folder.
The top right Plant List now displays the contents of the source project.

• Find the plant(s) you want to copy and drag and drop them into the relevant target project.

Project Costing
Plants grouped under projects can link directly to the Plantasia encyclopedia for their costing profile, or can be assigned
unique values specifically relating to the current project.
Linking cost profiles to the Plantasia encyclopedia:

• In the Navigation View, select the relevant project. This is now displayed above the Projects tree as the Current
Project.

• Under the Current Project tree, double-click the project folder.
• Click on the Plants folder.
• Select the relevant plant so its details are displayed in the Plant View.
By default, all plant cost data is initially derived from the Plantasia encyclopedia. This includes a plant reference,
supplier code, unit cost and any notes.

• Enter a quantity value for the plant. The total cost is then automatically calculated and displayed.
Creating a unique plant cost profile within a project:

• Select the relevant plant so its details are displayed in the Plant View.
• Deselect the Use Plant Database Settings pick box.
• Enter project related cost data and notes in the enabled boxes.
Notes

• Copying plants from one project to another will retain the cost profile of the source project. You can overwrite these
•

values in the target project or enable the Use Plant Database Settings pick box to link directly to the Plant
encyclopedia.
You can enter special characters to denote currency in the Unit Cost text box. Where a plant quantity is specified, the
Total Cost will automatically update whilst retaining these special characters.
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Sharing Plant Cards (vPlants)
Plant cards are the new way to send plant and flower information electronically. When you create new plant records in
Plantasia, all of the information including photos and illustrations is available in vPlant format. This means it can be
exchanged with friends or colleagues – at the click of a button*.
You can save any number of plant records as vPlants and send them in an email message. Plants can simply be
exported to any Windows Explorer folder for sending at any time.
* The vPlant feature requires that the recipient of the plant records is also running Plantasia Home Edition or
Professional (Trial Version or Full Product).

Working with Plant Cards
To create a vPlant from a plant record:

• Select the plant you want to save as a vPlant in the Plant List view.
• From the File menu, choose Export > Plant Card (vPlant) or click the Export vPlant tool in the toolbar.
• Type a name in the File name box, and then click Save.
The PDQ file format, used for vPlants, is a compound document format that is specific to plant records. This format
accommodates all plant information, illustrations and photos in a single file structure.
To import a vPlant file (including email attachment) into Plantasia:

• Using Windows Explorer, locate the folder where the vPlant (.pdq) file is stored or open the email message
containing the vPlant attachment.

• Double-click the vPlant file or email attachment to open it.
• In the Import vPlant display, click Import to save the record to the Plantasia database.
The plant record is saved under its associated plant category and automatically highlighted in the Plant List view.
Notes

• You can select multiple records to export/email by pressing Ctrl while you select each item in turn.
• You can drag plant records from the top-right Plant List view and drop them directly into Windows Explorer as
vPlants.

• The vPlant feature requires that the recipient of the plant records is also running Plantasia Home Edition or
Professional (Trial Version or Full Product).
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Plant Fact Sheets
You can generate plant fact sheets, automatically exported to your computer’s default word professor application (e.g.
Microsoft Word).
To select the plants ready for export as plant fact sheets:

• In the Navigation View, select the relevant project. This is now displayed above the Projects tree as the Current
Project.

• Under the Current Project tree, double-click the project folder.
• Click on the Plants folder.
The top right Plant List now displays the contents of the current project.
Exporting the plant list to Microsoft Word:

• From the File menu, choose Export > Plant Factsheet.
• Please wait a moment while the plant data is exported to Microsoft Word.
You can now work with the plant data in Microsoft Word and/or copy and paste into other applications.
Valid Merge Fields

• You can customize the design and layout of existing Microsoft Word format plant templates and define the merge
fields to use. For reference, the range of valid merge fields is shown below.

• The merge fields can be inserted into the Microsoft Word templates to replace existing default fields. For further
details on customizing standard templates, refer to the help topic Setting Options.
genus
species
variety
type
commonnames
origin
growthhabit
hardiness
climatezone

lowesttemp
heightlow
heighthigh
spreadlow
spreadhigh
leafretention
leafshape
grownfrom
growthrate

lightconditions
waterneeds
springcolor
summercolor
autumncolor
wintercolor
flowercolor
fruittype
interest

reference
suppliercode
unitcost
quantity
notes
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Export Table
Working with planting schedules and bill of materials are a critical component of any project. Creating these documents
presents many unique challenges. Among them are deciding what to schedule, how to format it and most importantly
accurately reporting it and keeping it up-to-date. Plantasia Professional provides the effective and reliable solution to all
of these issues.
The tools in Export Table let you query the Plantasia database for plant record properties and save them to a variety of
file formats. Unique formatting options mean you can pre-set the style for each spreadsheet and export only the data
that's critical to your needs.
With Export Table you can:

•
•
•
•
•
•
•

Query and compare any number of Plantasia records in tabular format.
Set spreadsheet styles with unique formatting options.
Merge tabled items based on user-defined criteria.
Quantify plant records for Bill of Materials.
Share record property templates with full network compatibility.
Preview schedules fast with an intuitive graphical interface.
Export data to Microsoft Excel, Access, CSV, XML and TXT.

Initial Steps
Export Table allows the easy extraction of plant record data to Microsoft Excel, Access and other formats. You can
attach helpful alias names to column headings and publish data from multiple plant categories. In addition, you can save
templates of selected records, properties, and alias information for reuse with other export tasks.
The advanced GUI interface employs tabs so you can easily jump to different stages in the export process or simply
query plant records for their property values at any time.
Below is the list of fields that can be exported:
Genus
Species
Variety
Common Names
Plant Type
Leaf Retention
Life Cycle
Reproduction
Plant Origin
Height High
Height Low
Spread High
Spread Low
Reference
Supplier Code
Unit Cost
Total Cost
Notes

[located on the Cost Profile tab]
[as above]
[as above]
[as above]
[as above]

Select the Export Table option from the Data Exchange left places bar.

Selecting Records and Properties
The Properties tab left-hand view displays the field names selected for extraction with the relevant record properties
shown opposite.
You can check/uncheck field names and record properties depending on the data you want to export to file. See also
notes on the General tab under Formatting Options help topic for further options.
Aliases can be assigned to field names by clicking in the relevant Alias column location in the Field Names view and
entering the chosen alias name.

• Working with Record Templates
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You can save and retrieve template files containing record property settings and apply them to the current group of
records. For example, you may want to automatically de-select fields or records with a particular name or value.
Templates can also store pre-defined aliases for field names.
To save a template based on the current Properties tab state, select the Templates button, followed by Save
Template. Save the template file to a suitable location. Templates are saved with the .ext file name extension.
To open a template and apply it to the current group of records, select the Templates button, followed by Open
Template and double-click the template file name to open it.
Notes

• Field Names and Record entries can be sorted into ascending or descending by simply clicking the desired column
heading. This will display a small direction arrow indicating the sort direction. To reverse the sort order, click the
column heading again.

Exporting the Data
The Table Preview tab contains a preview of the records and associated properties to be exported to file. The Flip View
feature provides an alternative view for the display of information and this affects how the data will be exported to file:

• Landscape. Each row contains a complete record. Landscape is the default view.
• Portrait. The records are sorted by the first field name in the list. The Value column displays the property value of the
record.
Clicking the Clipboard button copies all or selected portions of the table to the Windows clipboard.
Select the Columns button if you want to re-arrange the table columns into a particular order before exporting. The
column view permits the selection of individual column headings or multiple selections by using Shift or Ctrl.
Alternatively, you can slide the column heading until it is over the border between the column headings where you
want the column to appear – when a bold blue line marker appears, release the mouse button.
The Merge Rows group box contains a drop-down list of rules that define how rows within the table are merged,
depending on user-defined criteria. Clicking the Rules button displays the Merge Rule Manager dialog – from here
you can select an existing rule or create a completely new one based on your own personal preference.
When you are ready to save the data to file, click the Export button. From the Save As dialog, choose the file format
from those listed and enter the filename followed by Save. Depending on the amount of record data, this may take
several moments.

• Working with ‘Same Name’ Records
Export Table renames records of the same name but that have different properties that are found in the Plantasia
database. For each duplicate-named record after the first instance, with different properties, Export Table renames
the record by appending to the record name a tilde character (~) and the path name and file in which the record was
found.
Notes

• Field Names and Record entries can be sorted into ascending or descending by simply clicking the desired column
heading. This will display a small direction arrow indicating the sort direction. To reverse the sort order, click the
column heading again.

Formatting Options
Unique formatting options mean you can pre-set the style for each spreadsheet and export only the data that's critical to
your needs.
From the main Export Table display, select the Options button followed by the General tab. Pick the Export quantity
option if you want to include a quantity value with your exported data. This is useful to create a bill of materials and
introduces a Quantity column listing record quantities, located by default in column position 2. De-selecting this option
means that all objects selected for export will be exported to file independently of each other with a unique spreadsheet
entry.
Export Table allows for the export of records to the following file formats:
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•
•
•
•
•

Microsoft Excel Workbook (XLS)
Microsoft Access Database (MDB)
Comma Delimited (CSV)
Tab Delimited (TXT)
Extensible Markup Language (XML)

Note in order to view the exported files, you will need the relevant application to be installed. For example, to view files
with the extension XLS or MDB you will need to have installed either Microsoft Excel or Microsoft Access respectively.
The CSV, TXT and XML formats should open in your default Windows text file editor and/or Internet browser.
From the main Export Table display, select the Options button. Format tabs are available for each file format and include
a number of pre-formatting options:

• Microsoft Excel Workbook (XLS)
One record per sheet. Specifies that each individual record will be placed on a separate sheet.
Single sheet. Specifies that all records will be placed on a single sheet.
Export to odd lines. Record data is exported to odd lines only.
Start row. Determines the start row for exported data, when the Single sheet option is selected.
Include header row. Displays a header row with titles for each column.
Display header bold. Displays the header row bold.
Apply autofit to columns. Makes all column widths fit the contents of the exported data.
Autorun Microsoft Excel when done. Runs Excel and opens the spreadsheet when data is exported to the XLS
format.

• Microsoft Access Database (MDB)
One record per table. Specifies that each individual record will be placed in a separate table.
Single table. Specifies that all records will be placed in a single table.
Autorun Microsoft Access when done. Runs Access and opens the database when data is exported to the MDB
format.

• Extensible Markup Language (XML)
XML schema based on records. Formats the exported data based on a records-based rule vocabulary.
XML schema based on field data. Formats the exported data based on a fields-based rule vocabulary.
Open XML file when done. Opens the XML file with the system’s default XML editor when data is exported.

• Comma Delimited (CSV)
Include header row. Displays a header row with titles for each column.
Open CSV file when done. Opens the CSV file with the system’s default CSV editor when data is exported.

• Tab Delimited (TXT)
Include header row. Displays a header row with titles for each column.
Open TXT file when done. Opens the TXT file with the system’s default TXT editor when data is exported.
Notes

• The delimiter used in the comma-separated file format (CSV) is based on the locale – the list separator for the locale
separates the exported data.

• XML is a standard, simple, self-describing way of encoding both text and data so that content can be processed with
relatively little human intervention and exchanged across diverse hardware, operating system and applications.

• For record properties that will be assigned as field names in files exported to Microsoft Access, Export Table
substitutes an underscore character (_) for the characters shown in the following table:

Restricted Characters in Microsoft Access Fields
Character
.
!
[
]

Character Name
Period
Exclamation mark
Left square bracket
Right square bracket
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Customize your Workspace
To display or hide the Standard toolbar, on the View menu, click Toolbar.
Move the toolbar as follows:

• Click the move handle on a docked toolbar, or click the title bar on a floating toolbar.
• Drag the toolbar to a new location. If you drag the toolbar to the top edge of the program window, it becomes a
docked toolbar.
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